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Cybersecurity Data Science (CSDS)

TOPIC
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3. DISCOVER
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Scott Mongeau

Cybersecurity 

Data Science:
Perspectives on an 

Emerging Profession

• Defining key CSDS challenges

• Outline best practices

• Guidance to managers and 
practitioners in 
implementation of CSDS 
programs
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Key Learning Objectives

6
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Cybersecurity Services and Solutions:  Overview of Major Areas
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NIST 

Cybersecurity 

Framework
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Data Engineering Advanced Analytics Triage / Validate Remediate

?Diagnostics & 
patterns

Predictive 
modelling

Establishing 
baselines

Anomaly 
detection

Behavioral
insights

INVESTIGATORScientist CASE MGMT
DATA 

ENGINEERData Manager
Data Scientist Infosec Response

Cyber 
Investigator

Cybersecurity Data Science as a Process
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Predictive Detection Risk Optimization

Cybersecurity Analytics Maturity Curve

Data-aware 
Investigations

Anomaly Detection

• Big data management
• Flags, rules, and alerts
__________________
• Multivariate statistics, 

inference & 
unsupervised 
machine learning

• Groups extracted as 
baselines

CHASING 
PHANTOM 
PATTERNS



2. DATA

3. DISCOVER4. DETECT
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DEPLOY

1. FRAME
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Deploy

Cybersecurity Data Science (CSDS) Lifecycle

Frame

Model

EngineerValidate

Monitor

Explore
DECIDE

DISCOVERYDETECTION

InfoSec Response
Data Manager

Data Scientist
Cyber 

Investigator
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Security Operations Center (SOC)
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Emerging SOC Operational Drivers

Limitations of traditional 
signature and rules-
based approaches, 

requiring probabilistic 
and risk-focused models

Integrated situational 
awareness of network, 

device, and user behavior 
while reducing false alerts

Big & fast streaming data
needs to be stitched into 

‘smart data’

Need to build and 
validate efficacious 
machine learning 

models

Automation of manual 
investigation and 

remediation processes
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1. FRAME
Cybersecurity, Data Science, Logs
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Cybersecurity Data Science (CSDS)

TOPIC

1. FRAME

2. DATA

3. DISCOVER

4. DETECT

5. DEPLOY
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Learning Objectives
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Objectives of Context Setting
Establishing a foundation

19

• Data challenges (opportunities) in cybersecurity

• Data science foundations

• Demonstration / exercises 

• Insights into the ‘data deluge’ (network analytics)

• Log file analytics – from unstructured to structured
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CSDS Process
Unified Orchestration
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Cybersecurity Context
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Fraud-Cyber 
Hybrids

Social 
Engineering

Automated 
Attacks

Ransomware 
& 

Cryptojacking

State Actors

Evolving Threats

Internal 
Threats
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Hidden threats want to remain hidden (in the data)
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Source: Recorded Future via Fortune Magazine ‘A Hacker’s Tool Kit’ 
http://fortune.com/2017/10/25/cybercrime-spyware-marketplace/

http://fortune.com/2017/10/25/cybercrime-spyware-marketplace/
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FUD Fear, Uncertainty, Doubt
Increasing FREQUENCY, sophistication, and speed of attacks

• 51,000 attackers were blocked 
within days of site launch
• More than 1 million VPN-based 
attacks were blocked

Example of 
hacking tool 
‘ecosystem’:

Kali Linux
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Ambiguity effect Distinction bias Information bias Reactive devaluation
Anchoring or focalism Dread aversion Insensitivity to sample size Recency illusion
Anthropocentric thinking Dunning–Kruger effect Interoceptive bias Regressive bias

Anthropomorphism or 
personification Duration neglect Irrational escalation Restraint bias
Attentional bias Empathy gap Law of the instrument Rhyme as reason effect

Automation bias Endowment effect Less-is-better effect
Risk compensation / Peltzman 
effect

Availability heuristic Exaggerated expectation Look-elsewhere effect Selection bias

Availability cascade Experimenter's or expectation bias Loss aversion Selective perception
Backfire effect Focusing effect Mere exposure effect Semmelweis reflex

Bandwagon effect Forer effect or Barnum effect Money illusion Social comparison bias

Base rate fallacy or Base rate 
neglect Form function attribution bias Moral credential effect Social desirability bias

Belief bias Framing effect Negativity bias or Negativity effect Status quo bias

Ben Franklin effect
Frequency illusion or Baader–
Meinhof effect Neglect of probability Stereotyping

Berkson's paradox Functional fixedness Normalcy bias Subadditivity effect
Bias blind spot Gambler's fallacy Not invented here Subjective validation
Choice-supportive bias Groupthink Observer-expectancy effect Surrogation
Clustering illusion Hard–easy effect Omission bias Survivorship bias
Confirmation bias Hindsight bias Optimism bias Time-saving bias
Congruence bias Hostile attribution bias Ostrich effect Third-person effect
Conjunction fallacy Hot-hand fallacy Outcome bias Parkinson's law of triviality

Conservatism (belief revision) Hyperbolic discounting Overconfidence effect Unit bias

Continued influence effect Identifiable victim effect Pareidolia Weber–Fechner law
Contrast effect IKEA effect Pessimism bias Well travelled road effect
Courtesy bias Illicit transference Planning fallacy Zero-risk bias

Curse of knowledge Illusion of control Post-purchase rationalization
Declinism Illusion of validity Present bias
Decoy effect Illusory correlation Pro-innovation bias
Default effect Illusory truth effect Projection bias
Denomination effect Impact bias Pseudocertainty effect
Disposition effect Implicit association Reactance

https://en.wikipedia.org/wiki
/List_of_cognitive_biases

LIST OF 
COGNITIVE 

BIASES

https://en.wikipedia.org/wiki/List_of_cognitive_biases
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Difficulty 

Actioning 

Indicators
!

Proliferation of point 
analytics solutions 
impedes holistic risk-
based approach

High volumes of 
disconnected and 
disparate data sources

Lack of statistical and analytics 
approaches to establish alert validity

Too many alerts combined 
with slow and resource 
constrained investigations

Disconnected log 
sources of variable 
quality
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‘Drowning’ in Data Lakes
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Network Traffic
Tracking network traffic on a single device

30
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Exponential Growth in Network Traffic 

https://www.neustadt.fr/essays/against-a-user-hostile-web/

Using cookies and other tracking techniques, many 
“normal” web sites aggressively access and store our:

• Buying behavior 

• Personal finances

• Religious beliefs

• Political affiliations

• Health concerns and problems

• Camera / photos / microphone

• Device details

• IP address

• Present geolocation

• Changing physical locations

• Browser history

• Online purchases

• Profile information

https://www.neustadt.fr/essays/against-a-user-hostile-web/
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Marketing Analytics Ecosystem (>4000 companies)

32
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Demonstration / Exercise 
Network Traffic from Web Browsing

1.  Open ‘Wireshark’

2.  Click ‘Ethernet’

3.  Observe results
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Demonstration / Exercise 

Network Traffic from Simple Web Browsing
4.  Open ‘Internet Explorer’ (next to Wireshark)

5.  Go to a popular news website 

6.  Monitor Wireshark – what do you see?

7.  Sort on destination

7.  View ‘red’ & ‘black’ events 

See codes View => Coloring Rules

Note ‘Destination’ IP

8.  Go to http://ip-lookup.net
Where and what are these IPs?

http://ip-lookup.net/
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Wireshark Coloring Rules (default)
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Data Science Foundations
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https://www.sas.com/en_us/whitepapers/ponemon-how-security-
analytics-improves-cybersecurity-defenses-108679.html

* Survey of 621 global IT security practitioners

Level of difficulty in reducing false alerts*

https://www.sas.com/en_us/whitepapers/ponemon-how-security-analytics-improves-cybersecurity-defenses-108679.html
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Statistics
Pattern

Identification

Data
Science

Data 
Engineering

AI
Machine 
Learning

Data
Mining

As adapted from:  

Hall, P., et al. An Overview of Machine 
Learning with SAS Enterprise Miner.  SAS 
Institute Inc.

Cognitive
science
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VALUE

SO
P

H
IS

TI
C

A
TI

O
N

DESCRIPTIVE

PREDICTIVE

PRESCRIPTIVE

What happened?

What are 
trends?

What to do?
DATA ANALYTICS
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VALUE

SO
P

H
IS

TI
C

A
TI

O
N

DESCRIPTIVE

PREDICTIVE

PRESCRIPTIVE

Business
Intelligence (BI)

Econometrics 
Forecasting

Machine Learning

Operations 
Management

DATA ANALYTICS
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VALUE

SO
P

H
IS

TI
C

A
TI

O
N

DESCRIPTIVE

PREDICTIVE

PRESCRIPTIVE

What are trends and patterns 
in network and device usage? 

DATA ANALYTICS

What is the ‘normal’ behaviour 
of particular users or devices? 

How can we optimize 
remediation from focused alerts? 



43
Calvin.Andrus (2012) Depicts a mash-up of disciplines from which Data Science is derived  http://en.wikipedia.org/wiki/File:DataScienceDisciplines.png
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Calvin.Andrus (2012) Depicts a mash-up of disciplines from which Data Science is derived  http://en.wikipedia.org/wiki/File:DataScienceDisciplines.png

Engineering

Physics / ‘Hard 
Sciences’

Computer 
Science

Software 
Engineering

Economics / 
Finance

Social 
Sciences
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Scientific test…
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Descriptive Predictive Prescriptive

VALIDATE WITH DIAGNOSTICS

DIAGNOSTICS

i.e. statistical tests, causal and explanatory models, experiments, validation, model performance, etc.

47
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DESCRIPTIVE

DIAGNOSTICS

PREDICTIVE

PRESCRIPTIVE

Validating 
Factors & Causes

Optimizing 
Systems

Understanding 
Context & 
Meaning

SEMANTIC
Data 

visualization

DATA QUALITY

Business 
Intelligence

Understanding 
Patterns

Forecasting & 
Probabilities

Data Science Methods

VALUE

SO
P

H
IS

TI
C

A
TI

O
N

How do we substantiate our 
assumptions and hypothesizes? 

Is data quality 
reliable enough? 

What are 
limitations? 

How can we 
support experts 

with 
visualizations? 

What are the 
underlying 

human factors? 
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CSDS: Cybersecurity Data Science

Investigation tools that visualize complexity 
to improve investigator efficiency and 

decision making

Moving to real time 
detection and 

decisioning

Replacing rules with 
machine learning to reduce 

false alerts

Automation of manual 
processes and routine decisions

Data engineering to structured 
and integrate distributed big 

data into ‘smart data’
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Identify a security problem 

Identify data associated 
with problem

Clean and prepare the data

Experiment with methodsSelect a set of methods

Test and validate a solution

Operationalize solution

Cybersecurity Data Science: Typical Sequence
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Data Foundations: 
Log File Analytics
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The devil is in the data
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https://www.sas.com/en_us/whitepapers/ponemon-how-security-
analytics-improves-cybersecurity-defenses-108679.html

* Survey of 621 global IT security practitioners

Challenges preventing successful 
use of cybersecurity analytics*

https://www.sas.com/en_us/whitepapers/ponemon-how-security-analytics-improves-cybersecurity-defenses-108679.html
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SOURCE
Security Brief Magazine. (2016). “Analyze This! Who’s 
Implementing Security Analytics Now?” Available at 
https://www.sas.com/en_th/whitepapers/analyze-this-108217.html

Log files are the most common source of cybersecurity data…

https://www.sas.com/en_th/whitepapers/analyze-this-108217.html
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Operating systems
• Windows & registry events
• Unix logs

Data access
• File system
• ODBC
• RMDB (i.e. Oracle, SQL Server)

Authentication and Authorization Reports
• Active Directory Services
• Kerberos
• Proxy logs

Network logs
• Firewall logs
• Router 
• Traffic flows / packet captures

• Web server

• IIS W3C Logs, Apache

• HTTP Error Logs, URL Scans

• Resource access and performance

• Physical security access

• Malware and endpoint activity

• Failure and critical error reports 

• Specialized 

• Cloud applications (i.e. SaaS)

• Specialized systems / applications (i.e. 
ERP, thin client, specialized or home-
grown)

Security Log Data Sources

SOURCE:   Marty, Raffael. Applied Security Visualization. Pearson Education. 
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Use Cases: Security Log File Analytics

• Data / asset protection

• Preventive insights

• Identify / attribute attacks

• Incident response

• Incident root-cause analysis

• Compliance / risk reporting

• CISO dashboard

• User-entity behavioral analytics 
(UEBA)*

• Performance insights

• Optimization of resources

• Asset tracking

• Refining focused alerts

• Refining risk indicator metrics

• Enriching SIEM or other repositories

* Global Behavioral Analytics Market $3.5 billion projected market value by 2024

https://www.gminsights.com/industry-analysis/behavior-analytics-market?utm_source=iReach.com&utm_medium=referral&utm_campaign=Paid_iReach
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Diving into Cybersecurity Log Data

This exercise illustrates an example of examining 
cybersecurity log data with a variety of tools.
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Diving Right In!
EXERCISE:  Assessing Raw Log Data
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Demonstration / Exercise 
EXERCISE:  Assessing Raw Log Data

1.  Open ‘Notepad’

2. File => Open

3. Select ‘All Files (*.*)’ (lower right)

3.  D: => @CYBER => 1.FRAME => 
B.Log_Files => log_files => auth.log
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Demonstration / Exercise 
EXERCISE:  Assessing Semi-Structured Log Data

1.  Open ‘Sublime Text’

2.  File => Open File

3. D: => @CYBER => 1.FRAME => B.Log_Files
=> log_files => auth.log
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Processing Raw Cybersecurity Data – Example
EXERCISE:  Assessing Semi-Structured Log Data

1. What are we looking at – what is this?

• What system?  http://honeynet.org/challenges/2010_5_log_mysteries

• What types of logs / format? https://help.ubuntu.com/community/LinuxLogFiles

• How ‘verbose’?  Inherent structure (or lack thereof)?

• How might we build context (structure more granularly)?

• Schema availability? Data dictionary? Guidance from experts?

• For example, https://help.ubuntu.com/community/LinuxLogFiles

• Codes and indicators - descriptive versus opaque?

http://honeynet.org/challenges/2010_5_log_mysteries
https://help.ubuntu.com/community/LinuxLogFiles
https://help.ubuntu.com/community/LinuxLogFiles
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Cyber Forensics: Log File Analysis – HoneyNet Challenge

Virtual Server Log File Analysis (Virtual Ubuntu Linux Server) 

http://honeynet.org/challenges/2010_5_log_mysteries

1. Was the system compromised and when? How do you know that for sure?

2. If the system was compromised, what was the method used?

3. Can you locate how many attackers failed? If some succeeded, how many were they?  

4. How many stopped attacking after the first success? 

5. What happened after the brute force attack?

6. Locate the authentication logs. Was a brute force attack performed? if yes, how many?

7. What is the timeline of significant events? How certain are you of the timing?

8. Anything else that looks suspicious in the logs? Any misconfigurations? Other issues? 

9. Was an automatic tool used to perform the attack? if yes, which one?

10. What can you say about the attacker's goals and methods?

http://honeynet.org/challenges/2010_5_log_mysteries
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Processing Raw Cybersecurity Data – Example
EXERCISE:  Assessing Semi-Structured Log Data

3. Where do we store and transform subsequently?

• Flat files

• Database

• SIEM or other specialized repository

• ‘Data Lake’ (note: also can dump the raw logfile there too)

• Analytics platform

2. How can we reduce and structure?

• Parsing and extracting – many options

• Commercial tools (e.g. Splunk, Excel) and free tools (e.g. MS Log Parser)

• Scripting/programmatic (e.g. Perl, R, Python, SAS DS2, UNIX GREP, PowerShell)
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Demonstration / Exercise 
EXERCISE:  Assessing Semi-Structured Log Data

1.  Open ‘Log Parser 2.2’
2.  Examples of structured queries to try:

ALL FAILED AUTHENTICATION EVENTS:

logparser -i:TEXTLINE -o:csv "SELECT * INTO 

'D:\@CYBER\1.FRAME\B.Log_Files\results\log_extract_failed.txt' FROM 

'D:\@CYBER\1.FRAME\B.Log_Files\log_files\auth.log' WHERE Text LIKE '%Failed password%'"

ALL FAILED ROOT ACCESS AUTHENTICATION EVENTS – STRUCTURED:

logparser -i:TEXTLINE -o:csv "SELECT EXTRACT_TOKEN (Text, 8, ' ') AS UserName, 

EXTRACT_TOKEN (Text, 10, ' ') AS IPSource, EXTRACT_TOKEN (Text, 12, ' ') AS Port, 

EXTRACT_TOKEN (Text, 10, ' ') AS Protocol INTO 

'D:\@CYBER\1.FRAME\B.Log_Files\results\log_extract_failed_root.txt' FROM 

'D:\@CYBER\1.FRAME\B.Log_Files\log_files\auth.log' WHERE Text LIKE '%Failed password for root%'"

RESULTS D:\@CYBER\1.FRAME\B.Log_Files\results\

More fun with LogParser!
https://mlichtenberg.wordpress.com/2011/02/03/log
-parser-rocks-more-than-50-examples/

https://mlichtenberg.wordpress.com/2011/02/03/log-parser-rocks-more-than-50-examples/
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Exercise Review

67
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Conclusion

68
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Section Review

69
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Data Engineering Advanced Analytics Triage / Validate Remediate

?Diagnostics & 
patterns

Predictive 
modelling

Establishing 
baselines

Anomaly 
detection

Behavioral
insights

INVESTIGATORScientist CASE MGMT
DATA 

ENGINEERData Manager
Data Scientist Infosec Response

Cyber 
Investigator

Cybersecurity Data Science as a Process
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Anomaly Detection Predictive Detection
Risk Awareness / 

Resource Optimization

• Big data management
• Flags, rules, and alerts
__________________
• Structured data
• Counts of key 

measures
• Foundation for 

comparisons across 
entities and over time

Cybersecurity Analytics Maturity

Data-aware 
Investigations

CHASING 
PHANTOM 
PATTERNS
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Anomaly Detection Predictive Detection
Risk Awareness / 

Resource Optimization

• Big data management
• Flags, rules, and alerts
__________________
• Structured data
• Counts of key 

measures
• Foundation for 

comparisons across 
entities and over time

Cybersecurity Analytics Maturity

Data-aware 
Investigations
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Deploy

Cybersecurity Data Science (CSDS) Lifecycle

Frame

Model

EngineerValidate

Monitor

Explore
DECIDE

DISCOVERYDETECTION
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Cybersecurity Data Science (CSDS)

TOPIC

1. FRAME

2. DATA

3. DISCOVER

4. DETECT

5. DEPLOY


